3 Les clips

3.1 Création d'un clip avec animation interne
Examinons maintenant une facon de créer des clips d'animation Flash dans les fichiers flash.

Pour créer un nouveau clip dans un fichier d'animation Flash, nous rappelons qu'on peut
procéder comme suit:

e Menu Insert-> New symbol

e Selectionner Movie Clip et de donner un bon nom. On suggere de donner un nom comme
"Clip XXX" @ un objet qui contiendra une animation.

Sinon, vous pouvez aussi transformer un graphique existant en clip

e Dessiner un objet sur la scéne
e Clic-droit-> Convert to symbol. Sélectionnez Movie Clip'

3.2 Point d'alignement et point de transformation
Les points d'alignement

Aussi appelé point d'enregistrement (traduction directe de I'Anglais registration point)

Comme on l'a déja expliqué, chaque clip a un point d'alignement qui définit a quel endroit du
dessin correspondent les points de coordonnées x=0 et y=0 (par exemple, supérieur gauche ou
milieu). Lorsqu'on positionne un objet (par exemple dans une animation) on le positionnent par
rapport a ce point. Ce point d'alignement est affichée par une petite croix. Vous pouvez changer
ce point d'alignement en déplacant le dessin & un autre endroit. Il suffit d'éditer le symbol (double
clic sur une instance ou encore sur le symbole dans la library).

e Modifier I'objet dans la librairie (!). Puis le bouger ou mieux, utiliser le panneau "Properties":
Selectionner le tout (CTRL-A) puis mettre x=0 et y=0 si I'alignement doit étre en haut a
gauche (standard pour tout graphisme 2D). La croix au centre (+) que I'on voit sur le
graphisme représente le point d'alignement.

Note: Le point d'alignement (le centre de ses propres coordonnées) n'est pas la méme chose que
son point de transformation que vous pouvez déplacer avec le "Free Transform tool", c.f. en bas)

Convertir un groupe de graphiques en clip - le point d'alignement est au centre
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Les points de transformation

Le cercle blanc que vous pouvez ensuite voir au milieu d'un clip est appelé le point de
transformation ou point de rotation ou point cetnral (Center Point) et il a une fonction similaire. Il
définit I'endroit ou 'objet sera attaché a un guide de mouvement autour duquel il tourne. Vous
pouvez le déplacer vers un autre endroit avec I'outil de transformation libre (Free transform tool).
Par défaut, le point de transformation est au méme endroit que le point d'alignement. Pour
ramener un point de transformation au point d'alignement il faut double-cliquer dessus.

3.3 Modification d'un clip d'animation
Rappelons qu'il existe deux manieres de modifier un clip:

(1) En vue "stand-alone" vous pourrez voir uniquement les composantes du clip. Double-cliquez
sur I"'icdne clip" (pas son nom) dans la bibliothéque. Vous pouvez maintenant travailler avec sa
chronologie (timeline) interne, donc créer une animation interne a l'objet.

(2) Modifier un objet avec la scéne en arriere-plan. Si vous placez une instance du clip sur la
scéne et puis double-cliquez sur cette instance, vous pouvez modifier le clip tout en voyant les
objets de la scene alors que vous éditez juste le clip. Ci-dessous est une copie d'écran d'une
situation ou nous éditons un symbole de clip dans un contexte. La scéne elle-méme est "grisée"
(image et boutons).

Dans un clip vous pouvez faire ce que vous appris dans les tutoriels précédents, p.ex. dans

le Flash CS4 - Interpolation de mouvement. En d'autres termes, les clips ont leur propre scénario
comme vous pouvez le voir sur I'image ci-dessus. L'exemple ci-dessous implémente une
animation de type motion tween pour un pingouin, c'est a dire on fait bouger son bras droit.
Dans la copie d'écran ci-dessous en est en train d'éditer le "Pink pinguin clip". Vous pouvez voir
deux interpolations de mouvement. Le bras droit en train d'étre édité a son center point en haut
a droit pour pouvoir le tourner.

N'oubliez pas de revenir a la scene une fois que vous avez fini, par exemple en double-cliquant
sur la "scéne". Assurez-vous que vous savez a quel niveau vous modifiez et ou placer les objets!
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e Animation (voir d'abord)
e penguin-clip.fla (fichier *.fla)
e http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/ (répertoire)

3.4 Insérer une animation existante dans un nouveau document

Il existe des situations ou on désire juste copier un ou plusieurs calques (layers) et qui
contiennent des animations. C'est facile a condition d'utiliser le menu contextuel (clic droit).

Créez un nouveau symbole de type "movie clip" (Menu Insert->New Symbol ou CTRL-F8).

Allez sur votre animation déja réalisée et sélectionnez tous les layers dans la timeline. Pressez la
touche "CTRL" avant de sélectionner avec la souris. Il est également possible de ne copier que
certains frames. Ensuite clic-droit sur cette sélection et copy frames et coller tout dans votre
nouvelle animation en utilisant de nouveau le menu contextuel (clic droit) paste frames. Puis
glisser ce nouveau clip dans le layer/frame approprié du nouveau fichier Flash.

4 Pilotage de clips avec JavaScript
4.1 Pilotage d'un clip - survol

Créez un clip ou faites glisser un clip a partir de la bibliothéque sur la scene et donnez-lui tout-de-
suite un nom d'instance. Rappelez-vous que les noms d'instance doivent étre simple, par
exemple books et pas quelque chose comme animation géniale de livres. Un nom d'instance doit
commencer par une lettre, suivi par d'autres lettres, chiffres ou le signe "_" seulement.

Ensuite, il faut créer un bouton. N'importe quel symbole peut faire office de "button", y compris
I'objet animé lui-méme (lisez le tutoriel Animate CC 2015 HTML5 Canvas - Boutons. Le bouton
sera utilisé pour déclencher une fonctions une fois que I'utilisateur clic dessus:

this.monBouton.addEventListener ("click", startAnimation.bind(this));

Ensuite il faut définir la fonction startAnimation. Supposons que le nom de l'instance d'un clip

soit books. Vous pouvez maintenant utiliser du code JavaScript pour manipuler ce clip depuis
cette fonction. Par exemple:

Jouer un clip

this.books.play () ;

Pour arréter un clip

this.books.stop();

Rendre visible ou invisible un clip

this.books.visible = false;

this.books.visible = true;

Ci-dessous, il s'agit de code exemple. Donc si votre instance s'appelle pingu, il faut changer, par
ex:

this.pingu.play ();
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Astuce: Les clips vidéo commencent a jouer dés qu'ils se trouvent dans l'image (frame) courante.
Par exemple si vous les mettez dans dans un frame qui s'étale sur plusieurs frames, ils vont
continuer a jouer jusqu'a ce que l'exécution du scénario principal tombe sur une autre image clef
(keyframe) dans le méme layer. Si vous préférez que le clip soit arrété lors du chargement:

e Modifier le clip (double clic)
e Ajouter un calque "Actions" si nécessaire
e Ajouter cette méthode JavaScript dans le frame 1.

this.stop ();

Pour plus de détails, veuillez consulter les exemple (y compris leur code source) ci-dessous.

4.2 Lancer un clip apres x temps

Lorsque vous avez des animations qui commencent a devenir complexes comme des
cinématiques il peut devenir difficile de la faire exécuter sur un seul clip. Il est alors parfois plus
simple de construire des bouts d'animation séparément et de les intégrer par la suite. Imaginons
gue nous voulons faire I'animation d'une fontaine a levier. Nous voulons que de I'eau sorte un
moment aprés avoir commencé a actionner le levier. En résumé la cinématique se passe en
boucle en deux étapes:

1. la pompe est actionnée (I'eau ne sort pas).
2. la pompe est toujours actionnée et I'eau sort.

Si on faisait ¢a dans un seul clip alors ces deux étapes seraient répétés en boucle et donc dans
I'animation il y aurait des moments ou I'eau s'arréte de sortir.

— —

Or nous voulons qu'une fois que I'eau a commencé a sortir cela ne s'arréte plus d'ou I'utilité
d'avoir fait deux animations (une pour la fontaine et une autre pour l'eau).
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Il va donc falloir faire tourner les deux animations en boucle mais que I'animation de I'eau
commence a tourner quelques secondes plus tard aprés que I'animation de la fontaine ait
commenceé.

Procédure:

e Créer l'animation (clip) de la fontaine
e Créer l'animation de l'eau
e Insérer les deux animations dans la scene principale et leur donner un nom (fontaine et eau).

Une fois ces trois étapes exécutés nous allons devoir ajouter du code afin de lancer I'animation
de l'eau aprés x secondes. Il faudra donc écrire du code (f9 ou fn+f9). Voici la fonction qu'il
faudra insérer au début de votre code:

fairePause = function (symbole, visible, secs) {
symbole.stop () ;
if (visible == false) {
symbole.visible=false;
}
var intID = setlInterval (lancer, secs * 1000, symbole);
function lancer (symbole) {
clearInterval (intID) ;
if (visible == false) {
symbole.visible=true;
}
symbole.play () ;

}i

Cette fonction permet de lancer une animation aprés x secondes et de dire si I'animation doit
rester invisible ou pas tant qu'elle n'a pas été lancée. Ensuite il suffira juste de lancer I'animation
de la fontaine et celle de I'eau en utilisant la fonction fairePause. Il faudra plus que copier a la
suite le code suivant & la suite:
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this.fontaine.play();

fairePause (this.eau, false, 3);

Ici I'animation de I'eau sera lancée aprés 3 secondes et ne s'affichera pas avant les 3 secondes.
Si on veut qu'elle s'affiche des le chargement de la page il faudra mettre "true" a la place de
"false".

4.3 Répéter un clip x fois

Par défaut, lorsque I'on créé une animation celle-ci se répéte en boucle. Il serait parfois utile de
définir combien de fois nous voulons répéter une animation.

Procédure:

e Créer votre animation (appelée rectangle dans I'exemple)
e Insérer votre animation dans la scéne principale

Cas 1: Vous voulez que votre animation se répéte en boucle Tout est bon, vous n'avez plus rien
a faire.

Cas 2: Vous voulez que votre animation se répéte une seule fois
e Ouvrir votre animation

e Créer un nouveau calque (appelé Actions dans I'exemple)
e Insérer le code suivant dans le nouveau calque (f9 ou fn+f9):

this.stop();

e Placer ce code a la fin de I'animation:

Scenario
= @01l s 10 1v 20 2
] Actions ~ <* | O
A Calque 1 = =+ | 4 + * +|

Quand l'animation arrivera au frame 15 alors le this.stop(); s'exécutera et donc l'animation ne
sera plus répétée. Au final I'animation sera répétée qu'une seule fois.

Cas 3: Vous voulez que votre animation se répéte x fois

e Sur votre scéne principale, créer un nouveau calque (appelé Actions dans I'exemple)
e Insérer le code suivant dans le nouveau calque (f9 ou fn+f9):

compteurAnimationRectangle = 0;
//Sert a dire combien de fois on va répéter 1'animation
NbFoisAnimationRectangle = 3;

this.rectangle.play();

Il faudra créer une variable compteur et NbFois pour chaque animation que vous voudrez répéter
un nombre particulier de fois. La variable compteur doit étre insérée au début de votre code et
devra toujours valoir 0. La variable NbFois vaudra le nombre de fois que I'on veut répéter
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I'animation (3 dans lI'exemple). Cette variable sera placée avant l'instruction this.play(); de
I'animation en question (rectangle dans I'exemple).

e Ouvrir votre animation
e Créer un nouveau calque (appelé Actions dans I'exemple)
e Insérer le code suivant dans le nouveau calque (f9 ou fn+f9):

if (compteurAnimationRectangle >= 0) {

compteurAnimationRectangle++;

if (compteurAnimationRectangle == NbFoisAnimationRectangle) {
this.stop();
//this.visible=false;

compteurAnimationRectangle = 0O;

e Placer ce code a la fin de I'animation:

Scenario
= @01l s 10 1v 20 2
] Actions ~ <* | O
A Calque 1 = s |, + + +|

A chague fois l'animation arrivera au frame 15 alors le compteur compteurAnimationRectangle
sera incrémenté. Lorsque celui-ci vaudra la valeur que nous avons indiqué que nous voulons que
I'animation soit répétée grace a notre variable NbFoisAnimationRectangle alors this.stop(); sera
exécuté et donc I'animation ne sera plus répétée. Au final I'animation sera répétée
NbFoisAnimationRectangle fois. Si vous voulez qu'a la fin des NbFoisAnimationRectangle
répétitions votre animation disparaisse vous pouvez enlever les "/[" devant "this.visible=false;".

4.4 Faire un effet de mouseover

L'exemple de code ci-dessous montre comment faire un effet de mouseover. Lorsque le curseur
de la souris passe sur une forme, dans notre cas il s'agit d'une forme jaune (jaunel dans le
code), un textbox s'affiche contenant du texte faisant référence a cette forme. Il faut tout d'abord
dire a la scéne d'activer le mode mouse over, puis ouvrir un évenement (addEventListener) sur la
forme souhaitée. Cette méthode va récupéré l'action de I'utilisateur lorsqu'il passe la souris sur la
forme et appeller une fonction qui rend visible ou invisible le textbox.

// activation du mode mouseove

stage.enableMouseOver (30) ;

//application du eventListener sur la forme jaune pour appel a la
méthode qui permet de faire appraitre le texte contenu dans le textbox
this.jaunel.addEventListener ("mouseover", seeTextJaune.bind(this));
//application du eventListener sur la forme jaune pour appel a la
méthode qui permet de masquer le texte contenu dans le textbox
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this.jaunel.addEventListener ("mouseout", hideTextJaune.bind (this));
// déclaration de la fonction qui joue avec l'attribut visible du
textbox pour le rendre visible

function seeTextJaune () {

this.txtJaune.visible = true;

}

// déclaration de la fonction qui joue avec l'attribut visible du
textbox pour le rendre invisible

function hideTextJaune () {

this.txtJaune.visible = false;

}

4.5 Transformer une animation de la timeline principale en clip

Supposons que vous avez une animation intéressante dans un fichier *.fla que vous désirez
utiliser comme un clip intégre.

Etape 1 - Créez un nouveau symbole de clip dans un nouveau fichier

(voir ci-dessus)

e Supposons que le fichier est appelé clips.fla
e Menu Insert-> New symbol
e Select Movie Clip et donnez un bon nom

Vous devriez maintenant voir une scene vide, car vous étes en mode d'édition de ce nouveau
symbole.

Etape 2 - Copier les images a partir du fichier *. fla

¢ Maintenant ouvrez le fichier FLA avec la timeline animée. Supposons que le fichier est
appelé anim.fla

e Sélectionner tous les calques et les cadres que vous désirez récupérer (par exemple avec un
clic dans le premier layer/frame et un shift-clic dans le dernier layer/frame). Si vous voulez
récupérer le tout, c'est simple: Shift-clic sur tous les layers (a gauche de la timeline)

e Ensuite Clic droit quelque part dans cette sélection et Copy Frames.

¢ Maintenant retournez au fichier clips.fla ouvert (vous devriez toujours étre dans le mode
édition de symbole).

e Cliguer dans la frame 1 du calque 1 de ce clip encore vide

e Puir clic-droit et Paste Frames.

Voila, vous avez maintenant un clip avec une animation. Retour a la sceéne....

4.6 Exemple flying kite (CC 2014.2 / HTML)

Cet exemple montre comment jouer et arréter un clip embarqué avec un bouton. Regardez
d'abord l'application kite pour avoir une idée.

Etape 1 - Créez le clip qui va bouger

e Créez un clip (CTRL-F8, c.f. aussi ci-dessus). Dans I'exemple il s'appelle Kite clip. Il est
important de ne pas créer une animation dans la main timeline !

e Insérez un dessin dans ce nouveau clip.

e Transformez le dessin dans le clip en symbole (clip ou graphisme). Dans I'exemple c'est un
graphisme qui s'appelle kite. Sinon, on ne peut pas l'animer.
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e Donc, pour finir, vous avez un clip pour I'animation et un symbole (graphisme ou autre clip)
inséré dans le premier clip.

Etape 2 - Si nécessaire, glissez le clip sur la scéne et donnez lui un nom d'instance

e De la bibliothéque, glissez le clip sur la scene
e Dans le panneau de propriétés, donnez-lui un nom, par exemple kite

Vous devriez voir quelque chose comme sur la capture d'écran suivante:

ny Act
5 Animation

kite-movie-htmifta (Canvas)*

Un clip "kite" sur la scene

Etape 3 - Créer une interpolation de mouvement guidés pour le clip

e Double-cliquez sur l'instance du clip

e Ensuite, procédez comme expliqué dans les tutoriels sur I'animation, c-a-d. ajoutez

une animation de mouvement dans la timeline du clip (et non pas sur la timeline principale).

e efc..
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Etape 4 - Ajouter des boutons

e Retournez a la scéne
e Nous utilisons deux boutons
e Chacun de ces boutons a un nom d'instance: stopBtn et goBtn

Etape 5 - Ajoutez le code JavaScript

e Audébut, on arréte le clip avec this.kite.stop () ; . Sinon le clip pour le cerf-volant sera
automatiquement démarré.

e Un clic sur le goBtn lancera la fonction startlt lorsque I'utilisateur cliqgue dessus. Cette
fonction va alors exécuter this.kite.play ().

e Le bouton stopBtn est programmé de la méme maniere.

// Stop the kite clip from running
this.kite.stop();
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// registers the startIt function to be called when user clicks on goBtn

this.goBtn.addEventListener ("click", startIt.bind(this));

function startIt()
{
// Start the kite clip
// uncomment following line for debugging
console.log ("goBtn pressed" + ", kite=" + this.kite);

this.kite.play();

// registers the stopIt function to be called when user clicks on stopBtn

this.stopBtn.addEventListener ("click", stopIt.bind(this));

function stopIt()

{
// Stop the kite clip
// console.log ("goBtn pressed");
this.kite.stop();

Exemple
kite-movie-html.html
Source: kite-movie-html.fla
Répertoire: http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/
Notice: Il existe aussi une version Flash.

Exercice: Ajouter une autre animation clip. Par exemple un alien volant.
4.7 Exemple Perroquets

e Dans cet exemple, on crée 3 instances du méme clip.

e Ensuite pour lancer les animations, on transforme chacun en bouton. Donc
en cliquant sur un peroquet on le reveille.


http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/kite-movie-html.html
http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/kite-movie-html.fla
http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/
http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/kite-movie.fla

A

e = < >
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3 clips perroquets

Le clip perroquet a trois animations de mouvement, c'est-a-dire 2 rotations pour
la bouche et une pour la queue
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Ces animations sont déclenchés par des clics sur les instances. On utilise deux
méthodes différentes.

Fichiers:

e parrots-html.fla
e parrots-html.html

Sources clip art sur OpenClipart.org

e https://openclipart.org/detail/193812/parrot-remix
e https://openclipart.org/detail/190243/doves-on-a-branch-for-v-day

4.8 Exemple avion avec 2-3 niveaux d'imbrication de
symboles

Le principe est simple: On crée une bibliothéque de clips animés. Ensuite on
peut combiner de différentes maniéres. Par exemple: (a) créer des bouts
d'animation, (b) créer des clips qui les utilisent, (c) créer une instance dans la
timeline.


http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/parrots-html.fla
http://tecfa.unige.ch/guides/flash/cc-html5/embedded-movie-clips/parrots-html.html
https://openclipart.org/detail/193812/parrot-remix
https://openclipart.org/detail/190243/doves-on-a-branch-for-v-day
https://edutechwiki.unige.ch/fr/Fichier:Flash-cc-html-embedded-movie-clip-parrots-edit.png

Exemple:

e Clip A = Dessin hélice

e Clip B = Dessin avion

e Clip C = Clip hélice qui tourne

e Clip D = Avion qui contient B et 2 fois C

e Clip E = Animation avion qui bouge et qui contient deux fois D

Sources:

e avions-clip-html.fla (source CC clip)
e avions-clip-html.html

4.9 Aide a la programmation avec les code snippets
Animate CC dispose d'une aide pour programmer les interactions selon le

langage employé. On peut accéder a ces aides depuis le menu Window > Code
Snippets.

Pour illustrer ces aides, nous allons arréter une animation a un frame

1. Positionez-vous au frame ou vous souhaitez arréter I'animation
2. Puisque nous concevons une animation en HTML5/JS, aller sur le
menu HTMLS5 Canvas > Timeline Navigation > Stop at this

frame.

5 Créer des instances de clip avec
JavaScript

Je ne sais pas s'il existe un mécanisme similaire a celui de ActionScript
(voir Utilisation d'un clip de la library dans AS3 - Survol du langage ActionScript)

En attendant que je trouve une solution plus élégante, voici une procédure qui
marche:

En résumé;:

e Placez une instance sur la scéne (Angl stage) et mettez la en dehors de la
plage d'affichage. Cela force Flash a exporter le symbole en tant que classe,
lorsqu'il génére le code JavaScript pour CreateJs. Mais attention, ne rendez
pas l'objet invisible car il ne sera pas exporté. Je répéte,
évitez this.myInstance.visible = false;.A mon avis il s'agit d'un

bug.

e Ensuite dans le code ActionScript, vous trouvez la classe a instancier
comme propriété de la variable 1ib

var newObj = new lib.myClip();
par exemple
var personne = new Joe();

Dans l'exemple suivant, on stocke le résultat - une nouvelle instance
de lib.Parrot Clip - dans une propriété de this.
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this.newBird = new lib.Parrot Clip();

Exemple générateur de Perroquets (cliquer sur la branche):

e File: parrot-creation-html.html (exemple live)
e File: parrot-creation-html.fla (source)

// Clipart

// Parrot: https://openclipart.orqg/detail/193812/parrot-
remix

// Branch: https://openclipart.org/detail/190243/doves-

on-a-branch-for-v-day

// It seems that library objects cannot be exported.
// I therefore created an instance and had a look at the
JS code.

this.Joe.visible = false;

this.createBtn.addEventListener ("click",

createBird.bind (this)) ;

var counter = 1;

function createBird (ev)

{

//Notice the lib.something for creating an instance

this.newBird = new lib.Parrot Clip();
// position the thing
this.newBird.x = 180 + counter * 30;
this.newBird.y = 60 + counter * 8;
// add an event handler for hiding
this.newBird.on ("click", hideBird)
// add it to the stage
stage.addChild (this.newBird) ;

//console.log ("newBird=" + this.newBird + " at x="

+ this.newBird.x),

counter++;

function hideBird ()

{
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this.visible = false;



